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1.1

1 Overview of Third-party Options

1.1 Types of Options

This machine can be operated with the following two types of third-party options attached. You can attach 

either one or both of them as desired.

- Paper feeder option from third parties (called "Feeder" hereafter)

- Subsequent option from third parties (called "External Finisher" hereafter)

1.2 Optional Configuration

1.2.1 Attaching the Feeder to the Machine

Connect the Feeder to the right side of a single or double unit of Paper Feeder Unit PF-703 connected to 

the main body.

It cannot be connected to the right side of Paper Feeder Unit PF-706. It also cannot be attached to the main 

body directly or to a triple unit of Paper Feeder Unit PF-703.

You cannot connect any other options to the right side of the Feeder.

1.2.2 Attaching the External Finisher to the Machine

Connect the External Finisher to the left side of a single or double unit of Large Capacity Stacker LS-

505/Large Capacity Stacker LS-506. It cannot be connected to any options except for Large Capacity 

Stacker LS-505 and Large Capacity Stacker LS-506. Connecting the External Finisher does not limit the 

options to be connected to the right side of Large Capacity Stacker LS-505 or Large Capacity Stacker 

LS-506.

You cannot connect any other options to the left side of the External Finisher.
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Operating the Machine with the Feeder2 2.1
2 Operating the Machine with Third-party Options

2.1 Operating the Machine with the Feeder

2.1.1 Overview

When the Feeder is attached, perform the operation in the following order:

1 Turn ON the respective power switches of the main body and Feeder.

% For details on turning ON/OFF the power switch of the main body, refer to "2.2 Turning On/Off the 

Power" in [User's Guide - Copier] (or [User's Guide - Machine Information & Copier] for bizhub 

PRESS 1250P (Metric area), [User's Guide - Main Body] for bizhub PRESS 1250P (Inch area)).

% For details on turning ON/OFF the power switch of the Feeder, refer to the Feeder's documenta-

tion. If you turn OFF the power of the Feeder when that of the main body is ON, the message [Please 

confirm status of feeder] is displayed and the machine becomes unable to continue printing.

2 Make the necessary settings and load paper to the Feeder. For details, refer to the Feeder's documen-

tation.

3 Specify the paper conditions for the paper loaded to the Feeder on the main body. For the procedure, 

see page 2-2 in this document.

4 Make the necessary settings for the main body when copying or for the printer driver when printing, and 

start the output operation. For the procedure, see page 2-3 in this document.

5 Perform the following operations as necessary.

Adjustments of the reference positions on the print side: For details, see page 2-8 in this document.

Auto Tray Selection Setting: For details, see page 2-13 in this document.

2.1.2 Main Body Tray Setting

Make the tray settings on the main body.

1 Press [Tray Setting] on the Machine Screen.

2 Select [Feeder] under [Paper Tray].
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2.1 Operating the Machine with the Feeder 2
3 Specify the tray setting using the same paper conditions, such as Paper Size and Weight, for the Feed-

er.

Paper to be loaded to the Feeder must follow the specifications for the main body and Feeder.

Specifications for the main body

Paper size: 95 mm to 324 mm (3.73" to 12.76") widthwise, 133 mm to 483 mm (5.26" to 18.98") length-

wise

Weight: 40 to 350 g/m2 (11 to 93 lb Bond)

2.1.3 Copy Operations

To copy using paper fed from the Feeder, select [Feeder] in the paper tray area on the Copy Screen.

For details about other settings, refer to appropriate sections in [User's Guide - Copier]. (The copy function 

is not available for bizhub PRESS 1250P.)

1 Position the original.

2 Press [COPY] tab to display the Copy Screen.

3 Select [Feeder] in the paper tray area.

4 Select additional copy conditions, as desired.

5 Press Start on the control panel.

% You cannot output unless you return to the Copy Screen. Be sure to display the Copy Screen when 

you start printing.

2.1.4 Print Operations

The operation differs depending on your operating system and printer driver. Follow the appropriate proce-

dure in this section to perform printing.

Windows: Print operations using the PCL driver

Before printing

Right-click on the appropriate printer from [Devices and Printers] (in Windows 7) and click [Printer Properties]. 

Then, click the [Configure] tab to verify that [Feeder Unit] is selected in [Device Option].

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PCL]).

2 Click [Preferences] or [Properties].

The properties screen of the printer driver is displayed.
bizhub PRESS 1250/1250P/1052 2-3



Operating the Machine with the Feeder2 2.1
3 Click the [Basic] tab.

4 Select [Feeder] in [Paper Tray].

5 Specify the appropriate [Paper Size].

If you are using custom size paper, be sure to select [Custom Size] and specify the value set for the 

Feeder.

6 Click [Default Paper Type].

7 Select [Feeder] in [Paper Settings for Each Tray]. Specify [Paper Type], [Paper Weight], [Paper Color], 

and [Pre-Punched] as necessary.

8 Click [OK].

9 Click [OK] to start printing.
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2.1 Operating the Machine with the Feeder 2
Windows: Print operations using the PS Plug-in driver

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PS]).

2 Click [Preferences] or [Properties].

The properties screen of the printer driver is displayed.

3 Click the [Configure] tab to verify that [Feeder] is selected in [Paper Source Unit].

4 Click the [Paper] tab.

5 Select [Feeder] in [Tray Settings] - [Paper Tray]. Specify [Type], [Color], [Weight], and [Pre-Punched] as 

necessary.

6 Click the [Layout] tab.

7 Specify the appropriate [Paper Size].

If you are using custom size paper, be sure to select [PostScript Custom Page Size] and specify the 

value set for the Feeder.

8 Click [OK] to start printing.

Windows: Print operations using the PPD driver

Before printing

Right-click on the appropriate printer from [Devices and Printers] (in Windows 7) and click [Printer Properties]. 

Then, click the [Device Settings] tab to verify that [Feeder] is selected in [Paper Source Unit].

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PS (P)]).

2 Click [Preferences] or [Properties].

The print setting screen of the printer driver is displayed.
bizhub PRESS 1250/1250P/1052 2-5



Operating the Machine with the Feeder2 2.1
3 Click the [Paper/Quality] tab and select [Feeder] in [Paper Source]. Select [Media] (Paper Type) as nec-

essary.

4 Click [Advanced] in the lower right of the screen. Specify [Paper Weight], [Paper Color], and [Pre-

Punched] as necessary.

5 Select an appropriate paper size in [Paper/Output] - [Paper Size].

If you are using custom size paper, be sure to select [PostScript Custom Page Size] and specify the 

value set for the Feeder.

6 Click [OK].

7 Click [OK] to start printing.

Macintosh: Print operations using the PS Plug-in driver

Printing procedure

1 Select the print command in your application and select the appropriate printer driver name.

2 Select [KONICA MINOLTA 1250/1052 PS] from the pull-down list on the screen and click [Settings].

The screen of the printer driver is displayed.

3 Click the [Configure] tab to verify that [Feeder] is selected in [Paper Source Unit].

4 Click the [Paper] tab.
2-6 bizhub PRESS 1250/1250P/1052
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5 Select [Feeder] in [Tray Settings] - [Paper Tray]. Specify [Type], [Color], [Weight], and [Pre-Punched] as 

necessary.

6 Click the [Layout] tab.

7 Specify the appropriate [Paper Size].

If you are using custom size paper, be sure to select [PostScript Custom Page Size] and specify the 

value set for the Feeder.

8 Click [OK] to start printing.

Macintosh: Print operations using the PPD driver

Before printing

In the [Apple Menu], select [System Preferences] and click on the [Printers & Scanners] icon.

Select the appropriate printer driver, click [Options & Supplies], and click the [Options] tab. Then, verify that 

[Feeder] is selected in [Paper Source Unit].

Printing procedure

1 Select the print command in your application and select the appropriate printer driver name.

2 Select [Paper Feed] from the pull-down list on the screen and select [Feeder] in [All Pages From].

3 Select [Setup] from the pull-down list on the screen. Specify [Paper Weight], [Paper Color], and [Pre-

Punched] as necessary.

4 Select the appropriate paper size in [Paper Size].

If you are using custom size paper, be sure to select [Manage Custom Sizes] and specify the value set 

for the Feeder.

5 Click [Print] to start printing.
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2.1.5 Adjustments of Reference Positions on Print Side

Perform the following adjustments as part of the adjustments of the reference positions on the print side.

Printer FD-Magnification Adjustment (Side 2): Adjust magnification on the back side in paper feed direction 

of the printer engine. If transfer misalignment occurs on paper fed from the Feeder, adjust magnification in 

paper feed direction to mitigate the problem.

Printer CD-Magnification Adjustment (Side 2): Adjust magnification on the back side in crosswise direction 

of the printer engine. Change magnification in image control before exposure.

Printer Restart Timing Adjustment (Side 1/Side 2): Change LPH exposure timing to adjust the lead edge in 

paper feed direction of the printer engine. Make this adjustment if there is image loss or blank space on the 

lead edge on the front/back side of paper fed from the Feeder during printing. Use Printer Restart Timing Ad-

justment (Side 1) to adjust the lead edge on the front side in paper feed direction and Printer Restart Timing 

Adjustment (Side 2) to adjust that on the back side in paper feed direction.

d Reference

For details about the adjustments of the reference positions on the print side, refer to "5.2 [01 Machine Ad-

justment]" in [User's Guide - POD Administrator's Reference] (or "10.2 [01 Machine Adjustment]" in [User's 

Guide - Main Body] for bizhub PRESS 1250P (Inch area)).

NOTICE

The adjustments of the reference positions on the print side are advanced adjustments. Contact your service 
representative in advance of the adjustments.

NOTICE

While this section describes procedures only of Printer FD-Magnification Adjustment (Side 2), Printer CD-
Magnification Adjustment (Side 2), and Printer Restart Timing Adjustment (Side 1/Side 2), the following series 
of adjustments are needed to adjust the reference positions of the print side.

First, make adjustments for the front side in the following order:

- [01 Magnification Adjustment] - [01 Printer FD-Mag. Adj. (Side 1)]

- [01 Magnification Adjustment] - [03 Printer CD-Mag. Adj. (Side 1)]

- [02 Timing Adjustment] - [01 Printer Restart Timing (Side 1)]

Then, make adjustments for the back side in the following order:

- [01 Magnification Adjustment] - [02 Printer FD-Mag. Adj. (Side 2)]

- [01 Magnification Adjustment] - [04 Printer CD-Mag. Adj. (Side 2)]

- [02 Timing Adjustment] - [02 Printer Restart Timing (Side 2)]

When the above adjustments are complete for both front and back sides, make the following adjustment:

- [03 Centering Adjustment] - [01 Printer Centering Adjustment]

NOTICE

Perform the Both Sides Adjustment in order to adjust the magnification on the print side. For details of Both 
Sides Adjust, refer to [Additional Information] in the separate manual.

[01 Magnification Adjustment] - [02 Printer FD-Mag. Adj. (Side 2)]

If transfer misalignment occurs, adjust magnification in paper feed direction to mitigate the problem.

The following describes how to adjust the Feeder tray.

NOTICE

Make this adjustment after completing [01 Printer FD-Mag. Adj. (Side 1)].
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1 Load the Feeder with paper of A3 w/11 e 17 w. For details, refer to the Feeder's documentation.

2 Press [Tray Setting] on the Machine Screen to display the Tray Setting Screen.

3 Select [Feeder] and specify the paper size, paper type, and weight. Select A3 w/11 e 17 w for the paper 

size.

4 Press [Adjustment] on the Machine Screen to display the Adjustment Menu Screen.

5 Press [01 Machine Adjustment], [01 Magnification Adjustment], and [02 Printer FD-Mag. Adj. (Side 2)] 

in sequence.

The Printer FD-Mag. Adjustment (Side 2) Screen will be displayed.

6 Select [Feeder].

7 Press [Print Mode].

8 Confirm that [Feeder] is selected on the Print Mode Screen.

9 Press Start on the control panel. A sample pattern will be output.

10 Measure the resultant magnification in the paper feed direction.

Allowance: +/- 0.5% (full size)

Within 205.7 +/- 1 mm

11 Press [Close] to restore the Printer FD-Mag. Adjustment (Side 2) Screen.

12 If adjustment is required, use the touch panel keypad or control panel keypad to enter the setting data.

% Adjustable range: -10 (short) to 0 (long) (1 step = 0.05%)

% Use [+<->-] to specify the value to be positive or negative.

13 Press [Set] to change the setting with the current value.

14 Repeat the steps from 7 to 13 until the desired result is obtained.

15 Press [Return] to restore the Magnification Adjustment Menu Screen.
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[01 Magnification Adjustment] - [04 Printer CD-Mag. Adj. (Side 2)]

Change magnification in image control before exposure.

The following describes how to adjust the Feeder tray.

NOTICE

Make this adjustment after completing [03 Printer CD-Mag. Adj. (Side 1)].

1 Load the Feeder with paper of A3 w/11 e 17 w. For details, refer to the Feeder's documentation.

2 Press [Tray Setting] on the Machine Screen to display the Tray Setting Screen.

3 Select [Feeder] and specify the paper size, paper type, and weight. Select A3 w/11 e 17 w for the paper 

size.

4 Press [Adjustment] on the Machine Screen to display the Adjustment Menu Screen.

5 Press [01 Machine Adjustment], [01 Magnification Adjustment], and [04 Printer CD-Mag. Adj. (Side 2)] 

in sequence.

The Printer CD-Mag. Adjustment (Side 2) Screen will be displayed.

6 Select [Feeder].

7 Press [Print Mode].

8 Confirm that [Feeder] is selected on the Print Mode Screen.

9 Press Start on the control panel. A sample pattern will be output.

10 Measure the resultant magnification in the direction perpendicular to the paper feed direction.

Allowance: +/- 0.5% (full size)

Within 190 +/- 1 mm

11 Press [Close] to restore the Printer CD-Mag. Adjustment (Side 2) Screen.

12 If adjustment is required, use the touch panel keypad or control panel keypad to enter the setting data.

% Adjustable range: -10 (short) to 0 (long) (1 step = 0.05%)

% Use [+<->-] to specify the value to be positive or negative.
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2.1 Operating the Machine with the Feeder 2
13 Press [Set] to change the setting with the current value.

14 Repeat the steps from 7 to 13 until the desired result is obtained.

15 Press [Return] to restore the Magnification Adjustment Menu Screen.

[02 Timing Adjustment] - [01 Printer Restart Timing (Side 1)]

Make this adjustment if output includes image loss or blank space on lead edge on front side.

Select [All Tray] to adjust all trays including the Feeder tray.

The following describes how to adjust only the Feeder tray.

d Reference

For details on how to adjust all trays, refer to "5.2.5 [02 Timing Adjustment] - [01 Printer Restart Timing (Side 

1)]" in [User's Guide - POD Administrator's Reference] (or "10.2.5 [02 Timing Adjustment] - [01 Printer Restart 

Timing (Side 1)]" in [User's Guide - Main Body] for bizhub PRESS 1250P (Inch area)).

1 Load the Feeder with paper of A3 w/11 e 17 w. For details, refer to the Feeder's documentation.

2 Press [Tray Setting] on the Machine Screen to display the Tray Setting Screen.

3 Select [Feeder] and specify the paper size, paper type, and weight. Select A3 w/11 e 17 w for the paper 

size.

4 Press [Adjustment] on the Machine Screen to display the Adjustment Menu Screen.

5 Press [01 Machine Adjustment], [02 Timing Adjustment], and [01 Printer Restart Timing (Side 1)] in se-

quence.

The Printer Restart Timing Adjustment (Side 1) Screen will be displayed.

6 Select [Feeder Offset].

7 Press [Print Mode].

8 Confirm that [Feeder] is selected on the Print Mode Screen.

9 Press Start on the control panel. A sample pattern will be output.

10 Measure the resultant restart timing.

Allowance: 20 +/- 0.5 mm (metric A/B)

Allowance: 25.4 (1 inch) +/- 0.5 mm (inch series)
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11 Press [Close] to restore the Printer Restart Timing Adjustment (Side 1) Screen.

12 If adjustment is required, use the touch panel keypad or control panel keypad to enter the setting data.

% Adjustable range: -30 (short) to 30 (long) (1 step = 0.1 mm)

% Use [+<->-] to specify the value to be positive or negative.

13 Press [Set] to change the setting with the current value.

14 Repeat the steps from 7 to 13 until the desired result is obtained.

15 Press [Return] to restore the Timing Adjustment Menu Screen.

[02 Timing Adjustment] - [02 Printer Restart Timing (Side 2)]

Make this adjustment if output includes image loss or blank space on lead edge on back side.

The following describes how to adjust the Feeder tray.

1 Load the Feeder with paper of A3 w/11 e 17 w. For details, refer to the Feeder's documentation.

2 Press [Tray Setting] on the Machine Screen to display the Tray Setting Screen.

3 Select [Feeder] and specify the paper size, paper type, and weight. Select A3 w/11 e 17 w for the paper 

size.

4 Press [Adjustment] on the Machine Screen to display the Adjustment Menu Screen.

5 Press [01 Machine Adjustment], [02 Timing Adjustment], and [02 Printer Restart Timing (Side 2)] in se-

quence.

The Printer Restart Timing Adjustment (Side 2) Screen will be displayed.

6 Select [Feeder Offset].

7 Press [Print Mode].

8 Confirm that [Feeder] is selected on the Print Mode Screen.
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9 Press Start on the control panel. A sample pattern will be output.

10 Measure the resultant restart timing.

Allowance: 20 +/- 0.5 mm (metric A/B)

Allowance: 25.4 (1 inch) +/- 0.5 mm (inch series)

11 Press [Close] to restore the Printer Restart Timing Adjustment (Side 2) Screen.

12 If adjustment is required, use the touch panel keypad or control panel keypad to enter the setting data.

% Adjustable range: -30 (short) to 30 (long) (1 step = 0.1 mm)

% Use [+<->-] to specify the value to be positive or negative.

13 Press [Set] to change the setting with the current value.

14 Repeat the steps from 7 to 13 until the desired result is obtained.

15 Press [Return] to restore the Timing Adjustment Menu Screen.

2.1.6 Auto Tray Selection Setting

When [Feeder ]is selected under [ATS/APS Switch] on the screen displayed by pressing [02 Function Setting] - 

[01 Paper Tray Setting] - [01 Auto Tray Selection Setting] on the Utility Menu Screen, the Auto Tray Switch (ATS) 

function supplies paper from the Feeder if the main body tray or Paper Feeder Unit PF-703 becomes empty.

On the other hand, if the Feeder is empty, the Auto Tray Switch (ATS) function does not supply paper from 

the main body tray or Paper Feeder Unit PF-703.
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2.2 Operating the Machine with the External Finisher

2.2.1 Overview

When the External Finisher is attached, perform the operation in the following order:

1 Turn ON the respective power switches of the main body and External Finisher.

% For details on turning ON/OFF the power switch of the main body, refer to "2.2 Turning On/Off the 

Power" in [User's Guide - Copier] (or [User's Guide - Machine Information & Copier] for bizhub 

PRESS 1250P (Metric area), [User's Guide - Main Body] for bizhub PRESS 1250P (Inch area)).

% For details on turning ON/OFF the power switch of the External Finisher, refer to the External Fin-

isher's documentation. If you turn OFF the power of the External Finisher when that of the main body 

is ON, the message [Please confirm status of external finisher] is displayed and the machine be-

comes unable to continue printing.

2 Configure the [Tray Setting] on the main body and load paper to the tray. For details, refer to "3.3.1 Out-

lines of Tray Setting Operations" in [User's Guide - POD Administrator's Reference] (or "4.2.3 Outlines 

of Tray Setting Operations" in [User's Guide - Main Body] for bizhub PRESS 1250P (Inch area)).

3 Make the External Finisher settings according to the [Tray Setting] on the main body. For details, refer 

to the External Finisher's documentation.

% Paper may slightly expand or contract due to a change in the ambient temperature and humidity 

conditions or the machine's condition, a difference in the paper type, or heat in the fusing section. 

When using the External Finisher which requires precise finishing such as accurate folding, it is rec-

ommended that you print sample pages. After the sample print is output, measure the paper size, 

thickness, and so forth of the output sheet and then enter the values for the External Finisher. See 

page 2-23 for details.

% Although frequency of printing samples varies with the level of precision required for the output, it 

is recommended that you do so when you are loading paper or changing the output conditions.

4 Make the necessary settings for the main body when copying or for the printer driver when printing, and 

start the output operation.

For the procedure, see page 2-14 or page 2-15 in this document.

The output sheets are sent to the External Finisher.

2.2.2 Copy Operations

To output to the External Finisher, select [External FNS] on the Output Setting Screen.

For details about other settings, refer to appropriate sections in [User's Guide - Copier]. (The copy function 

is not available for bizhub PRESS 1250P.)

1 Position the original.

2 Press [Output Setting] on the Copy Screen to display the Output Setting Screen.

3 Select [External FNS] in the Output area.

% When [External FNS] is selected, selectable output modes are limited to [Sort] and [Group]. Also the 

Face, Order, and 180 Deg. Rotation are fixed to [Face Up], [1 to N], and [OFF], respectively.
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4 Confirm that the External Finisher tray is selected as the destination of output paper.

5 Select additional copy conditions, as desired.

6 Press Start on the control panel.

% You cannot output unless you return to the Copy Screen. Be sure to display the Copy Screen when 

you start printing.

2.2.3 Print Operations

The operation differs depending on your operating system and printer driver. Follow the appropriate proce-

dure in this section to perform printing using the External Finisher.

Windows: Print operations using the PCL driver

Before printing

Right-click on the appropriate printer from [Devices and Printers] (in Windows 7) and click [Printer Properties]. 

Then, click the [Configure] tab to verify that [External Finisher Unit] is selected in [Device Option].

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PCL]).

2 Click [Preferences] or [Properties].

The properties screen of the printer driver is displayed.

3 Click the [Finish] tab.
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4 Select the [External Finisher Mode] checkbox and select [External Finisher Tray] in [Output Tray].

5 Click [OK] to start printing.

Windows: Print operations using the PS Plug-in driver

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PS]).

2 Click [Preferences] or [Properties].

The properties screen of the printer driver is displayed.

3 Click the [Configure] tab to verify that [External Finisher] is selected as the feeding unit.

4 Click the [Finishing] tab.

5 Select the [External Finisher] checkbox and select [External Finisher] in [Output Tray].

6 Click [OK] to start printing.
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Windows: Print operations using the PPD driver

Before printing

Right-click on the appropriate printer from [Devices and Printers] (in Windows 7) and click [Printer Properties]. 

Then, click the [Device Settings] tab to verify that [External Finisher] is selected.

Printing procedure

1 Select the print command in your application and select the appropriate printer driver (the default name 

is [KONICA MINOLTA 1250/1052 PS (P)]).

2 Click [Preferences] or [Properties].

The print setting screen of the printer driver is displayed.

3 Click [Advanced] in the lower right of the screen to specify the following items:

[Output Tray]: [External Finisher]

[External Finisher]: [On]

4 Click [OK].

5 Click [OK] to start printing.

Macintosh: Print operations using the PS Plug-in driver

Printing procedure

1 Select the print command in your application and select the appropriate printer driver name.

2 Select [KONICA MINOLTA 1250/1052 PS] from the pull-down list on the screen and click [Settings].

The screen of the printer driver is displayed.

3 Click the [Configure] tab to verify that [External Finisher] is selected as the feeding unit.

4 Click the [Finishing] tab.
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5 Select the [External Finisher] checkbox and select [External Finisher] in [Output Tray].

6 Click [OK] to start printing.

Macintosh: Print operations using the PPD driver

Before printing

In the [Apple Menu], select [System Preferences] and click on the [Printers & Scanners] icon.

Select the appropriate printer driver, click [Options & Supplies], and click the [Options] tab. Then, verify that 

[External Finisher] is selected.

Printing procedure

1 Select the print command in your application and select the appropriate printer driver name.

2 Select [Finishing] from the pull-down list on the screen.

3 Select the [External Finisher] checkbox and select [External Finisher] in [Output Tray].

4 Click [Print] to start printing.
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2.2.4 Sample Print (Copying)

This section describes how to print samples using [Wait] after storing the scan data via [Scan to HDD].

You can also store the scan data on the HDD from [HDD Store] in [Output Setting] provided on the Copy 

Screen.[Proof] or [Suspended] on the Recall Screen can also be used to print samples as needed.

1 Press [Scan to HDD] on the Store Screen.

2 Press [Personal Folder] or [Public Folder].

3 Select the user box to store the scan data.

With [Personal Folder] selected: Select the desired folder, press [To User Box], and then select the de-

sired user box.
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With [Public Folder] selected: Select the desired user box.

If a password is set for the folder or user box, enter the password and press [OK].

Reference

For details about how to create a personal folder, refer to "4.2 Create a Personal Folder" in [User's 

Guide - Network Scanner].

For details about how to create a user box, refer to "4.3 Create a User Box" in [User's Guide - Network 

Scanner].

4 Press [New File Store].

5 Enter a file name, then press [OK].
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6 Set scan conditions, as desired.

7 Position the original, and then press Start on the control panel.

8 On a confirmation dialog, press [Yes] to continue the scanning operation, or press [No] to finish.

When you pressed [Yes], repeat step 2 and following operations.

9 On the Recall Screen, select the user box in which the data to be output is stored.

If a password is set for the folder or user box, enter the password and press [OK].

10 Select the file to be output.
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11 Select [Wait], and then press [Print].

12 Enter the print quantity with the keypad, then press [OK].

13 On a confirmation dialog, press [Yes] to continue the recalling operation, or press [No] to finish.

When you pressed [Yes], repeat step 9 and following operations.

14 On the Mode Check Screen of the main body's control panel, change the output settings (External Fin-

isher (External FNS): ON, Output Tray: secondary (sub) tray of Large Capacity Stacker LS-505 or 

Large Capacity Stacker LS-506) and start printing samples.

Press [Proof Copy] to output a whole set or press [Proof Print(1st Sheet)] to output only the first sheet.
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15 Measure the paper size, thickness, and so forth of the output sheet and then enter the values for the 

External Finisher. The items to be set vary with the External Finisher being used. For details, refer to the 

External Finisher's documentation.

16 On the Mode Check Screen of the main body's control panel, change the output settings (External Fin-

isher (External FNS): ON, Output Tray: External Finisher tray) and start printing samples.

Press [Proof Copy] to output a whole set or press [Proof Print(1st Sheet)] to output only the first sheet.

17 Check the finish of the output sheet.

18 If the expected result is not achieved, repeat steps 16 and 17 to make adjustments. For details, refer to 

the External Finisher's documentation.

19 Press [Close] to close the Mode Check Screen.

20 Press Start on the control panel to start the actual printing.

2.2.5 Sample Print (Printing)

This section describes how to print samples using a Wait job.

Proof print or Hold print (displayed as "Suspended" when operated from the control panel) can also be used 

to print samples as needed.

1 Send a Wait job from the printer driver.

PCL driver: Select [Basic] - [Print Method] then select [Wait Mode].

PS Plug-in driver (Windows/Macintosh): Select [Workflow] - [Print Mode] then select [Wait Mode].

PPD driver (Windows): Select [Advanced] - [Print Mode] then select [Wait Mode].

PPD driver (Macintosh): Select [Security] - [Print Mode] then select [Wait Mode].

2 On the Mode Check Screen of the main body's control panel, change the output settings (External Fin-

isher (External FNS): ON, Output Tray: secondary (sub) tray of Large Capacity Stacker LS-505 or 

Large Capacity Stacker LS-506) and start printing samples.
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Press [Proof Copy] to output a whole set or press [Proof Print(1st Sheet)] to output only the first sheet.

3 Measure the paper size, thickness, and so forth of the output sheet and then enter the values for the 

External Finisher. The items to be set vary with the External Finisher being used. For details, refer to the 

External Finisher's documentation.

4 On the Mode Check Screen of the main body's control panel, change the output settings (External Fin-

isher (External FNS): ON, Output Tray: External Finisher tray) and start printing samples.

Press [Proof Copy] to output a whole set or press [Proof Print(1st Sheet)] to output only the first sheet.
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5 Check the finish of the output sheet.

6 If the expected result is not achieved, repeat steps 4 and 5 to make adjustments. For details, refer to 

the External Finisher's documentation.

7 Press [Close] to close the Mode Check Screen.

8 Press Start on the control panel to start the actual printing.
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3 If the Machine Halts

If a paper jam or other trouble occurs in a third-party option, the machine stops and will not continue its op-

eration until all causes including the paper jam are resolved.

When there is a paper jam, as with any other device, the message [Mishandled paper] and jam number(s) are 

displayed on the screen. Take the appropriate actions to clear all the locations.

3.1 Operations on the Jam Position Screen and Disposal Instruction 
Screen

1 When [Illustration] is displayed on the Jam Position Screen, press [Illustration].

The screen illustrating the method for the disposal action will be displayed.

% Press [JAM Position] to return to the Jam Position Screen.

2 Follow the instruction on the screen to remove mishandled paper.

NOTICE

Before clearing a paper jam, be sure to check the caution label locations inside the machine. Before 
removing the paper jammed in a third-party option, check the appropriate documentation for the pro-
cedure of clearing a paper jam and the caution label locations.

3 When completed, the Machine Screen will be restored.

% If any misfeed location is left, the Jam Position Screen will be restored with the next disposal pro-

cedure in the message area and the location number in the jam position display. Repeat steps 1 and 

2 until all the locations are cleared.

When all procedures for removing paper have been completed, it returns to the Machine Screen.

4 After warming up is complete, press Start on the control panel to resume printing.

Jam number on the Jam Position Screen
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No. Location

46 External Finisher

57 Feeder
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3.2 Halting of the Machine Not Involving Paper Jam

If the machine stops due to a reason other than a paper jam, follow the instruction on the screen.
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